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1. Introduction 

With the aid of this software, HLA class I and HLA class II antibody identification using the Bio-Rad 
AbIdent can be easily and effectively evaluated. After data have been evaluated, results can be stored 
and printed out. 
 
The software has interfaces to all standard microtiter plate readers and automated microtiter plate 
processors. With the aid of the user friendly setup menu, laboratory-specific adjustments can be carried 
out quickly and easily. 
 
 
 
 
 
 
 
 
 

2. Installation 

2.1 Minimum system requirements 

Computer: 

• operating system: Windows 2000 or better 

• Screen resolution: 1024 x 768 or better 

• Minimum free harddisk space: 20 MB 

• For importing pipettor data: access to pipettor files (e.g. LAN connection) 

• For importing photometer data: Serial interface 

 
 

Note: 

If your PC does not meet these minimum requirements, this may result in errors, 

extended waiting times and possibly program malfunctions. 

Installation requires Administrator rights. 

Recommendations for connecting up a photometer: 

• Screened serial cable, length <= 2m 

• Transfer rate <= 9600 baud 

• Do not position cables close to electromagnetic fields 

• Tuning the parameters in the reader 
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2.2 Installation instructions 

Log on to the system as the Administrator. Insert the CD in the CD drive. Run the BABIDsetup.exe 
program from the CD. 
 
1. First you will see the "Installation Wizard" followed by the welcome message: 

 

 
Click <Next> to display the following sequence of windows: 
 
2. Licence agreement 
Select "I accept the terms in the license agreement". The <Next> button cannot be clicked until you do so. 
 
3. Note on installed files- <Next> 
 
4. PC user and company- <Next> 
 
5. Suggested target folder 
The default folder is C:\Program Files\Bio-Rad\BABIDxxxx\. (xxxx = current version). 
 
Changing the target folder: 
Enter a changed folder name in this window or simply click <Next> to confirm the default. 
 
6. Overview of settings before the installation itself begins 
Click <Install> to confirm → the installation will then begin 
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8. When installation is complete, you will see the following message: 

 

 
Click <Finish> to complete. 
 
When installation has completed, you will see new entries as desktop icons and in the All Programs start 
menu called "Bio-Rad AbIdent xxxx (Reader)" and "Bio-Rad AbIdent xxxx (Pipettor)". 
 



 AbIdent Software 5.2d User Manual 
  

 

5 

3. Data import 

3.1 Importing updated lots 

Lot specific software updates can be found on the internet at http://www.medizinische-diagnostik-
dreieich.de. You can find new lot data by following these steps: 

• Open “Download service” 

• “Transplantation” 

• “Transplantation AbScreen / AbIdent / AbCross 

→ A table with these products is shown. Choose the required product (AbIdent Class I or II). Click 

“SW” of the new lot and then <Save>. A zip folder is downloaded. 

Extract the files in the zip folder to the C:\Program Files\Bio-Rad\BABIDxxxx\LotFiles folder. 

3.2 Importing pipettor files 

To import pipettor data, run the "Bio-Rad AbIdent xxxx (Pipettor)" program. You will see the Bio-Rad 
Pipettor interface.  

→ You will see a list of the microplates which can be read in.  
 
If this list is blank even though you have pipetted some microplates, please check the following settings 
(also described in Chapter 5):  

- Is the right path entered under "Instrument files folder"? It is necessary to enter a path here for the 

exported pipettor files (select with the browse button  on the right). 

- Is the right pipettor selected? (check the Settings). 

- Is the right instrument file template selected? (check the Settings). 

- Is the right software selected? (check the Settings. The "AbIdent software" must be selected). 

- Are the correct identification parameters for the test names in Class I/II selected? The words 
entered here (and separated from each other by commas) must all be contained in the test names 
in order to display the imported file (check Settings). 
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Select the corresponding files for import by clicking them once with the mouse, select the corresponding 
lot from the "Lot file" menu and import data by clicking <Start import>.  

→ After the import, the names of the imported microplates are marked with a green tick and the name is 
modified. This is to prevent the same microplates being imported again: 

 

Note: 

It is important to know the names of the patients which were used when the samples 

were entered because the software uses these names and sorts the data in the 

selection menu for samples to be imported by these names.  
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Click <Start AbIdent > to run the AbIdent software.  

 

In the "File" menu, select <Start Class I Sample> or <Start Class II Sample>.  

 

AbIdent Sample File Selection 
Select the sample names from a list.  

AbIdent Lot Number 
Select the AbIdent lot you are using. 

Click <OK> to confirm. 
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3.3 Importing a reader file 

To import reader data, run the "Bio-Rad AbIdent xxxx (Reader)" program. The Bio-Rad AdIdent software 
will start.  

 

In the "File" menu, select <Start Class I Sample> or <Start Class II Sample>.  

 

AbIdent Sample File Selection 
Enter a name for the results file manually.  

AbIdent Lot Number 

Select the AbIdent lot you are using.  
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Click <OK> to generate an empty Reader file. You will see a dialogue window which enables you to 
control the Reader.  

 

By default, an Anthos HT II DWL reader is used. Refer to chapter 5.1 to find out how to configure the 
software to use other types of readers.  

Select <Read Plate> to initiate the read process. In the next window, you can enter the current ambient 
laboratory temperature during the AbIdent ELISA tests. Select the temperature and click <OK>.  

The Bio-Rad Reader interface opens. Start the read process by clicking <Start>.  

 

 

Reader data is automatically read in by the software.  
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4. Working with the software 

The workflow is as follows: 

• Read in the microplate (as a file or using the Reader) 

• If you use the Reader: enter the sample numbers 

• Evaluate results and edit them. 

• Save results 

• Print results 

• Optionally, Export results 

After a pipettor or Reader file has been imported, the screen automatically displays the "Explore" tab 
showing these results.  

 

Click the tabs visible at the top of the window to navigate between views.  
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4.1 "Sample Info" tab 

The "Sample Info" tab contains details of the patients examined and additional details of the lab technician 
performing the test or analysis, the kit lots used and the test parameters in the laboratory.  

Note: 

Those fields marked with an asterisk can not be edited using mouse or keyboard.  

 

Technician I.D.: 

If required, enter the name of the person in the laboratory performing the analysis. By default, the 
computer enters the name of the current Windows user. This can be changed.  

Sample Draw Date:  

The date when the blood sample was taken can be entered here.  

Sample Receive Date:  

The date when the sample reached the laboratory can be entered here.  
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*ELISA Test Date:  

The date the AbIdent test was performed appears here.  

*Date of Report File:  

The date the report is generated appears here once it has been generated.  

*Sample I.D.:  

The sample number appears here 

Patient Name / Patient I.D.:  

The name or lab ID of the patient may be entered here.  

Extra Fields 1 and 2:  

Freeform text comments can be entered here.  

*AbIdent Lot Number:  

The Lot Number of the AbIdent lot used is displayed here.  

Test Temp °C: 

The ambient temperature in the laboratory during the test can be entered here.  

Patient Phenotype:  

Click <Patient Phenotype> to enter the patient's HLA type. To do so, you may mark the corresponding 
specificities in the list. Click <OK> to confirm.  

If the patient's phenotype is entered here, these specificities may be suppressed on the "Test Parameters" 
tab.  
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4.2 "Plate" tab 

The "Plate" tab contains the microplate layout of the AbIdent lot used. The file name is shown in brackets 
(e.g. 7135.1.R00). The "R" stands for "Raw Data".  
 

 

The information on the individual wells on the microplate is shown below by reference to one well, well A7:  
 
Line 1: "50CBC": internal information on the well 

Line 2: The tick indicates that the well was included in the analysis. If more than three 3 wells are 
excluded from the analysis, the software will not be able to evaluate this sample. 
The number "0.918" describes the background adjustment factor (BAF) for this well. The cut-off 
for this well is defined by 2 x the mean of the negative controls multiplied by the BAF. This factor 
compensates for varying reaction strengths in the cells used.  

Line 3: The number "0.457" describes the OD value of the sample after deducting the blank.  
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4.3 "Test Parameters" tab 

Test settings are made on the "Test Parameters" tab.  
 

 

Test-specific parameters can be set under "Limits and Counts".  

Positive Cut-off Factor:  

The value by which the mean value of the negative controls is to be multiplied in order to calculate the cut-
off.  

Negative Control Average OD:  

Calculation of the mean values from four negative controls after deducting the blank. 

Positive Control Average OD: 

Calculation of the positive control sample after deducting the blank. 

Inclusion of cut-off:  

The inclusion cut-off is recalculated for each sample and indicates that an antigen or Creg (=Cross 
reactive group) is no longer included in the short tail list if this would mean that the overall percentage of 
50.1% is not attained.  
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R value cut-off:  

The R value cut-off indicates that if the R value is e.g. 0.25 or less, that antigen or Creg is no longer 
included in the short tail list. 
In the "Suppressed Items" window, certain specificities can be excluded from the analysis.  

Suppress Patient Phenotype:  

Here, the patient's HLA specificities can be excluded from the analysis.  

Note: 

For this purpose, the patient's HLA type data must be entered on the "Sample Info" 

tab.  

Suppressed Antigens:  

Certain HLA specificities can be excluded from the analysis here.  

Neg Controls / Panel Well:  

This option displays the microplate positions deactivated in the "Plate" tab.  
In the "Antigen and Creg Files" window, you can select whether you wish to analyse using individual HLA 
antigens or Cregs (Cross Reactive Groups).  
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4.4 "Explore" tab 

The "Explore" tab is subdivided into 3 sections describing the results of the AbIdent ELISA.  

 

PRA: 

The PRA (Panel Reactive Antibodies) indicates the percentage of all antigen wells on the entire panel that 
reacted positively. The total number of positive wells (the example shows 16) is shown as a percentage of 
the entire panel (= 40 wells). 16 / 40 x 100% = 40.0%. 

Antigen Short Tail Results: 

The "Antigen Short Tail Results" show a statistically calculated HLA antigen identification for the patient. 
The main criterion is the number of correct positive wells for a certain specificity in relation to the total 
number of wells containing that specificity. If this ratio concludes with the specifications in the “Test 
Parameters” tab (Inclusion Cutoff, R-Value Cutoff), the respective specificity appears in the list. The 
specificity with the most correct positive reactions appears on top of the list. 
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Second place is taken by the specificity with the next best match of correct positive wells in relation to the 
number of all positive wells for the same specificity. Those wells included in the first line are no longer 
included and are subtracted from the total number of reactions. 

Explanation using patient 21849 as an example: 2 of a total of 40 wells contain HLA antigens against A31. 
There was a positive reaction in these two wells. The Incl is therefore 100%. The columns marked "++","+-
","-+" and "--" show the distribution of the reactions. This totals 40. The sample is then analysed for further 
HLA antibodies present in significant numbers. One more specificity is listed: A28. 4 of the remaining 38 
wells (40-2 = 38) on the microplate contain this specificity. 3 wells of the sample react as "correct 
positive". Ten more positive reactions are evaluated as false-positives and one is evaluated as false 
negative because one A28 reaction did not take place. The total number of reactions for specificity A28 is 
38 (see calculation). Since the sample reacts with A28 in 3 out of a total of 4 wells, the Incl is 75. The 
cumulative Incl is higher because it includes the positive reactions of wells covering A31: the total of A31 
and A28 specific wells is 6, of which 5 are detected as reactions with correct positives. 

Explanations of the "Antigen Short Tail Results" table from left to right: 

"Antigen" = name of the specificity or Creg (cross reactive group) 

"Count" = the total number of wells covering the respective specificity 

"Sum" = the total number of wells for identifying one patient (Class I: 40 wells, Class II: 30 wells) 

"++" = "correct positive"; indicates how many wells reacted 

"+-" = "false positive"; shows how many wells reacted positive with other antigens 

"-+" = "false negative"; shows how many reactions for the respective specificity did not take place 

"- -" = "correct negative"; shows how many reactions were negative for other specificities 

"Incl" = if the number "Cnt" matches with the number "++", this makes 100 %; "Incl" is calculated 
using the following equation: "Incl" = "++" / "Cnt" x 100% 

"Cum Incl" = cumulated "Incl"; this value is equal to the Incl value for the first position of the list but higher 
in line two because it includes the reaction of the specificity in line one and so on. 

"r" = shows the reproducibility of test results. An R value of e.g. 0.6 indicates that 60% of the 
results are correct positive and 40% non-specific. 
Explanation using an example: If 13 false positive reactions were included with 2 correct ones, 
the value of R is 0.296. If there are no non-specific, false positive or false negative reactions, 
the value of R will be exactly 1.000. 

"Cum r" = cumulative value for R; is the same as the specificity at the top of the table; with the second 
specificity, the reactions of the first specificity are included and so on. 

"X
2" 

= means chi squared, which is a statistical measurement of the credibility of the test results. 
The higher the value of chi squared, the more accurate and credible the meaning of the test 
results.  

"Cum X
2"

 = cumulative value of chi squared 

"Avg.OD" = average OD. The difference between Rel.OD and Avg.OD can be seen from the following 
formula: Rel.OD = Avg.OD - well cut-off 

Independent Antigen Statistics:  

"Independent Antigen Statistics" means that each specificity is considered and evaluated independently. 
There are therefore no cumulative results. 

This table lists all the specificities on the microplate, beginning with the largest number of positive 
reactions in the sample having a certain specificity. There is no relation between the specificities listed (as 
is the case with the Antigen Short Tail Results table) and the reactivity of each specificity is assessed 
individually. 

Antigen Panel List: 
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"Antigen Panel List" means that each well is assessed individually. Wells are listed in the order of their 
"relative OD values". The letter "X" shows whether or not the user has omitted wells from examination. 
"Well" shows the position of the well and "PanID" is its internal designation. The "Relative OD" shows how 
close the OD value is to the cut-off value and whether it is above (= positive rel. OD value) or below it (= 
negative rel. OD value). A positive rel. OD value which is above the cut-off value and is still positive after 
deduction of the cut-off value is a positive reaction. "Antigens" shows all the specificities in a well. 

Menu functions in the Antigen Panel List:  

A right-click in the Antigen Panel List opens the Panel List Menu window.  

 

• "Tail Antigens/Cregs" highlights the specificities shown in the Short Tail Results.  

• Under "Selected Antigens/Cregs", individual antigens or Cregs can be highlighted.  

• "Relative Optical Density" sorts antigen wells by their measured relative optical density.  

• "Raw Optical Density" sorts antigen wells by their measured values for optical density.  

• "Unsorted" sorts antigen wells the way they are arranged on the microplate.  

• Selecting "View +/- / Blank Control Wells" will include the OD values for control wells in the list.  

• Selecting "View Naw & MAb" will include the No-Antigen Well (Naw) and the well with only the 
monoclonal capture antibody (MAb – only for HLA Class II) in the list.  
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• "Display Raw Optical Density" shows the measured OD values.  

• "Normalize Histogram" shows all the OD values in relation to the OD value of the positive control 
sample. If this option is not activated, all the OD values will be shown relative to 4.0.  

• "Increase or Decrease Cut-off Factor from ..." raises or lowers the cut-off factor in such a way that the 
last positive microplate position becomes negative or the first negative microplate position becomes 
positive.  

• "Reset Cut-off Factor to 2.000" resets the cut-off factor to its default value of 2.000.  

• Selecting either "Use Antigens" or "Use Cregs" allows the user to choose between the evaluation 
method.  

• "Print Panel Window" prints the Antigen Panel List.  
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4.5 "Report" tab 

Sample result reports can be generated in the "Report" tab. To do so, do a right-click on the white field. 
The following menu appears:  

 

There are five possible displays to choose from:  

Report Style A and Report Style B: 

These report types contain first of all the "Antigen Panel List" and, below that, the "Antigen Short Tail 
Results". The difference between Type A and Type B is the target printer (laser or colour printer). 

Report Style C 

This report type contains "Antigen Short Tail Results" first, followed by the "Antigen Panel List". 

Report Style D 

This report type only includes the "Antigen Short Tail Results". 

Printout 

Results are printed by right-clicking and selecting <Print Report>. 
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4.6 Other tabs 

In the "View" menu further tabs can be displayed besides the tabs shown by default (chapter 4.1 to 4.5).  

• "Lot Number.Qid/Pan" tab 

The lot-specific microplate assembly is displayed.  

 

• "Antigens/Cregs" tab 

Antigens and Cregs are listed.  
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• "Creg Definition" tab 

Antigens are assigned to the respective cregs.  

 

• "ELISA Data File" tab 

Reader data for the tested sample is shown.  
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4.7 Saving results 

If a new sample is imported or the program is closed, the user is automatically asked whether the changes 
are to be saved and in what format:  
 

 

Do Not Save Changes:  

Changes are not saved. If the sample is reopened, the user will be presented with the default settings as 
they were when the sample file was imported.  

Save Using New Run Number 2:  

The number of the run is incremented by one. Modifications are saved and the original file is left 
untouched.  

Overwrite Run Number 0:  

Modifications are saved under the same file name, which means the original file will be overwritten.  

Cancel This Operation:  

Aborts the action without saving modifications. 
 
 
 
 
 
 
 
 

4.8 Exiting the program 

• Either use the standard Windows method by clicking the  in the top right-hand corner or 

• Navigate to "File" - "Exit" 
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5. Appendix 

5.1 Configuring the reader 

You may configure the Reader settings. This is normally the task of the Bio-Rad product specialists! 
If you modify these settings without contacting Bio-Rad first, Bio-Rad cannot accept any guarantee for 
error-free functioning of the interface with the Reader! 
 
Navigate to "File – Start Class I Sample or Start Class II Sample – manual entry of the microplate number 
and selection of the lot number" – select <Read Plate> - you will see the Reader window: 

 

Select <Setup> to access the setup menu. 
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The required settings for the filter and output file(s) can be set here. 
 
The COM settings can be accessed via a different button: 

 
 
Save and leave the Reader changes by clicking <OK> 
 
 
 
 
You currently have a choice of 7 readers. 

 

Note: 

Please also refer to the recommendations relating to Readers in the chapter on 

System Requirements. 
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5.2 Configuring the pipettor 

Before you can take over pipettor data, the AbIdent software has to be configured in such a way that the 
paths, microplate names and microplate assignments tally with the results produced by the pipetter. When 
the software is installed, the most typical settings are selected. However, changes may be made as 
required.  

This is normally the task of the Bio-Rad product specialists! If you modify these settings without 
contacting Bio-Rad first, Bio-Rad cannot accept any guarantee for error-free functioning of the interface 
with the pipetter! Our customer services staff will be pleased to assist you. 

5.2.1 Settings: Tecan 

After starting the program version Bio-Rad AbIdent xxxx (pipetter), selecting the <Setup> option takes the 
user to the dialogue screen for pipetter settings. The required settings can now be made: 

 

Pipettor name: Enter the name of the pipetter 
Data input mask: Tecan: rmp*.dat 

Quickstep: *.txt 
BepIII: *. 

Input file path: normally the import folder of the AbIdent software 

Output file name: This file is generated by the software itself. It is expected to be in the import folder and 
must be named "instrument.dat". 
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5.2.2 Settings: Quickstep 

The settings for Quickstep are identical to those for Tecan, with two minor exceptions: 
 

• The driver is called "Quickstep" and the file name is *.txt 
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